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INTRODUCTION

The purpose of this self-assessment is to provide community 
leaders with a simple and inexpensive method of predicting if 
their community will reach and maintain an acceptable level 
of functioning after coastal-flooding, or other disasters such 
as wind storm, ice storm, or flash flood . Experienced Local 
Planners, Engineers, Code Enforcement Officers, Floodplain 
Managers or Administrators can complete this self-assessment 
using maps generated from the New York Sea Grant (NYSG) Lake 
Ontario Inundation WebMap, NYSG Lake Ontario Inundation 
Map Package, and/or weather disaster (see appendices starting 
on page 19), and existing sources of information from their 
community . It might be helpful to use one booklet per event 
(coastal-flooding or weather disaster) . 

This assessment may identify problems your community should 
address before the next event and where resources should be 
allocated . Results of the assessment are presented as a Resilience 
Index that estimates the adaptability of your community to 
coastal-flooding and/or weather disasters . This self-assessment 
was created to identify areas in which your community may 
become more resilient . Your community’s Resilience Index is an 
internal evaluation tool and should not be used to compare your 
community with others . 

The Resilience Index and methodology do not replace a detailed 
study, just as self-diagnosing an ailment using a medical website 
is not a substitution for a checkup and tests by a physician . . 
But, the Resilience Index resulting from this Community 
Self-Assessment may encourage your community to seek 
further consultation .

For this exercise, please consider the following 
definitions:

DISASTER RESILIENCE is the ability of a community 
to withstand and recover and to protect critical 
assets from all-hazards disasters.

RESILIENCE is a community’s ability to anticipate, 
prepare for, withstand and recover from extreme 
weather events such as storms, flooding and 
drought. Resilient communities are better able 
to sustain vital services, healthy ecosystems and 
economic vitality, making them less susceptible 
to future hazardous events and more attractive to 
businesses and residents alike. 

NOTE: This Community Self-Assessment is date-specific and should be 
periodically applied as the community grows and/or the landscape changes, 
such as when shoreline erosion accelerates. Your community officials should 
conduct new assessments on a regular basis (annual, biannual, etc.) because 
of this growth and/or change.

RESULTS OVERVIEW 

After completing this self-assessment, you should complete the 
summary that will help you determine your Resilience Index (see 
pages 15 and 16) .

The Resilience Index used in this self-assessment will be defined as 
LOW, MEDIUM or HIGH .

The rating will give you an idea of how long it may take your 
community to provide basic services and reoccupy homes and 
businesses after a disaster . 

For more details about interpreting Resilience Index results, go to 
page 17 .

Waves crashing through a gate in Monroe County, NY. Photo: Coastal Flooding 
Survey Project, Cornell University and New York Sea Grant.
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BUILD YOUR SCENARIOS

The primary goal of this self-assessment is to improve community resilience for two types of scenarios: coastal-flooding, and weather 
disasters . The risk of coastal-flooding along the Great Lakes and embayments typically begins in the spring and can last several months 
depending on various system-wide factors . The risk of weather disasters (i .e ., ice storms, blizzards, flash floods) occurs throughout the 
Great Lakes region over shorter time periods (hours to days) during all seasons . Both can have devastating impacts . 

This assessment will guide you through how to build scenarios for coastal-flooding and weather disasters for your community . You may 
decide to focus on either coastal-flooding or weather disasters, or consider the cumulative impacts of each occurring at the same time .

Coastal Flooding
A Benchmark high water level and two Credible Worst-Case 
Scenarios have been provided . In order to visualize inundation 
for the purposes of this assessment, you will use the NYSG 
Lake Ontario Inundation WebMap or the NYSG Lake Ontario 
Inundation Map Package to generate flood risk maps for different 
water levels . Some water levels provided in the mapping tools 
have occurred and others have not . Because wave run-up data 
are not readily available, the generated maps assume only 
flat water . In addition, they do not account for stormwater or 
groundwater . To see examples of generated maps go to pages 
23, 24, 25, and 29 .

For reference included is water level 247 .3 feet (the upper limit 
of the four-foot range defined in the Lake Ontario-St . Lawrence 
River Management Plan 1958DD), the development line that 
was previously used by many communities . Theoretically, your 
community is able to function at this water level . You will use 
249 feet as the Benchmark water level . This is near the peak water 
level Lake Ontario reached during 2017, and just under the new 
peak reached in 2019 . As an example, you might consider two 
future scenarios: 249 .5 feet and 250 feet . For this example, these 
would be Credible Worst-Case Scenario 1 and 2 respectively . It is 
important to note that to date these water levels have  
not been projected and are being provided as possible  
future scenarios . 

Weather Disasters
Extreme weather events are occurring more frequently in 
our region . Example weather disasters are being provided to 
help you think about how they might impact the resilience of 
your community .

As a group, designate a location within your community as the 
“strike zone”, meaning where the weather disaster will occur for 
your scenarios . Remember, this is a self-assessment, so try to 
designate a strike zone that will give you the most information 
about where the community vulnerabilities may be for the 
weather disaster/s of interest . Use the definitions of Benchmark 
and Credible Worst-Case Scenario to complete the table on page 
7 . These will then be referred as the Benchmark and Credible 
Worst-Case Scenario to complete the rest of the Resilience Index 
for the strike zone you have identified . You are encouraged to 
draw upon local knowledge and your from experience as well as 
the narratives and charts describing weather disasters that have 
been provided (Appendices pages 32-41) . 

Benchmark Section
Select a Benchmark storm from the ones provided on pages 
32–41 of the Appendices . These events have actually occurred 
within the region . Please select and transfer the variables you are 
interested in from the Benchmark column of the chart provided 
in Appendices pages 32–41 to the table on page 7 . You may 
also draw upon local knowledge and experience to include 
a different bad storm event as a Benchmark that is greater in 
intensity and/or specific to your geographic location than the 
ones provided .

Credible Worst-Case Scenario Section
The Credible Worst-Case Scenarios provided in the charts on 
Appendices pages 32–41 are at least 50% worse than their 
Benchmarks . Again, transfer the variables you are interested 
in from the Credible Worst-Case Scenario column of the chart 
provided in Appendices pages 32–41 to the table on page 7 . 
If you added variables to your benchmark that are not from 
Appendices pages 32–41, please increase them by 50% for 
this section . 
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Coastal-Flooding Scenarios

Reference Benchmark Water Level Credible Worst-Case  
Scenario 1

Credible Worst-Case  
Scenario 2

Water Level (ft) 247.3 249 249.5 250

Weather Disaster Scenarios

Weather Disaster Type: _____________________________________  Strike Zone: ________________________________________

Variables of Interest* Benchmark Credible Worst-Case Scenario 1

* Variables found in pages 32–41 of the Appendices.
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CRITICAL INFRASTRUCTURE AND FACILITIES

The following lists are key indicators that will give a preliminary assessment of your community’s resilience by considering how critical 
infrastructure and facilities are impacted and whether they will function after coastal-flooding and/or a weather disaster . A more detailed 
assessment process is available in the FEMA 386-2 publication (fema.gov) . 

Critical Infrastructure and Facilities Benchmark Credible Worst-
Case Scenario 1

Credible Worst-
Case Scenario 2

Infrastructure/
facility functions 

after disaster*

Water Level (feet): 249 249.5 250

Weather Disaster (list):

Example: Power grid ü ü

Section A: Critical Infrastructure

Wastewater treatment system

Wastewater lift stations

Storm drains

Power grid: transformers

Power grid: substations

Alternate energy sources (i .e ., solar, wind, etc .)

Public water supply

Transportation/evacuation routes

Large-scale shoreline protection (i .e ., breakwater, 
breakwall, etc .)
Places of mass gathering (i .e ., fairgrounds, shopping 
center, etc .)

Others (list):

Total check marks for Section A:

Check each box associated with the critical infrastructure 
and facilities that are impacted for each of the scenarios . 
Determine the impact for coastal-flooding scenarios by 
examining the maps generated using the NYSG Lake Ontario 
Inundation WebMap Appendix page 26, NYSG Lake Ontario 
Inundation Map Package (Appendix page 20) . For weather 
disaster scenarios, determine the impact by considering the 
strike zone designated by your team . Then put a check mark 
in the last column if the infrastructure or facility is functional 
during or after your benchmark for coastal-flooding and/
or weather disaster . Use the total check marks in the last 
column for Section A and Section B to complete page 15, 
“Determining Your Resilience Index .”

1.
Useful Definitions 
A critical facility (also called critical action) typically 
provides crucial services/functions to a community, 
particularly during and after crisis, such as coastal-flooding 
and weather disasters . Critical facilities include, but are 
not limited to: emergency operations centers, designated 
public shelters, schools and day care centers, nursing 
homes, hospitals and medical facilities, police, fire and 
emergency response installations, vital data storage centers, 
power generating stations, drinking water and wastewater 
treatment plants, and places where hazardous wastes 
are located . 

*Identify all critical infrastructure that are functioning after the event, even if they were not impacted.

http://fema.gov
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Critical Infrastructure and Facilities Benchmark Credible Worst-
Case Scenario 1

Credible Worst-
Case Scenario 2

Infrastructure/
facility functions 

after disaster*

Water Level (feet): 249 249.5 250

Weather Disaster (list):

Example: Power grid ü ü

Section B: Critical Facilities**

Municipal Hall 

Municipal Department of Public Works

Critical record storage
Other government building(s) (list):

Fuel (i .e ., diesel, gas) stations for disaster response 
operations

Police station or other law enforcement building(s)

Jail

Fire station(s)/Emergency Medical Service

Communications main office or substations

Emergency operation center

Access to areas suitable for disaster response staging

Access to points of distribution (staging areas for 
necessities for residents)

Evacuation shelter(s)

Hospital(s)

Vulnerable populations (i .e ., mobility impaired, day 
care, group homes, people likely to refuse mandatory 
evacuation, etc .)

Hazardous materials facilities (gas stations, marinas 
with fuel or other hazard materials, etc .)

Private industries with hazardous materials

Abandoned, deteriorated, or underused sites and 
buildings

Total check marks for Section B:

*Identify all critical facilities that are functioning after the event, even if they were not impacted. 
* *Critical facilities may be defined a certain way in an ordinance. However, each community may identify other structures they consider critical.

Additional Notes
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TRANSPORTATION ISSUES

Assuming Credible Worst-Case Scenario 1 for coastal-flooding or Benchmark for weather disasters, if any of the following affect your 
transportation/evacuation route(s), will your community regain a pre-event level of service during or after a coastal-flooding event or 
after a weather disaster event? Check Yes or No .

Transportation Issue* Yes No

Will primary bridge(s) be out for less than one week?

Will roads blocked by storm debris (trees, trash, etc .) be cleared in less than one week?

Will washouts (roads) be passable in less than one week?

Will flood-prone areas (roads, low-lying areas) be operational within one week?

Is public transportation available to assist evacuation of residents unable to evacuate on their own?

Is there more than one evacuation route?

Is there a plan for post disaster traffic management?

Are there ways to limit access in disaster areas for those other than critical personnel (emergency responders, 
disaster responders, etc .)?

Is there sufficient parking for emergency/disaster response personnel and logistical response staging stations?

Do road lights/stoplights have a reduced/no power setting, or alternate energy backup?

Other (list):

Total number of Yes answers and No answers:

Additional Notes

*Some communities use waterways as transportation infrastructure and/or evacuation routes (canals, docks, streams, marinas, and ferries).

DID YOU KNOW?

Communities with a channel 
debris removal plan can 
receive up to 200 points 
through the National 
Flood Insurance Program’s 
Community Rating System.

2.
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Additional Notes

COMMUNITY PLANS AND AGREEMENTS

 Does your community have the following plans, personnel, or agreements in place? Check Yes or No .

Does your community: Yes No

Participate in the National Flood Insurance Program’s Community Rating System?

Use an early flood warning system?

Have a floodplain manager/administrator certified by Association of Floodplain Managers (ASFPM)?

Have Planning Board/Zoning Board of Appeals with formal training in planning?

Have staff (Planning, Code Enforcement Officer (CEO), Building Inspector, Building Department) with credentials 
from the American Institute of Certified Planners (AICP) or degrees/professional experience in planning?
Have FEMA-approved and NY State Department of Homeland Security and Environmental Services-approved  
All-Hazard Mitigation Plan (AHMP)?

If you have an AHMP, has it been revised in the past two years?

If you have an AHMP, does it include climate projections?

Have a disaster mitigation equipment inventory (i .e ., sand, sand bags, sand bagging machine, pumps, etc .)?

Have Memorandums of Understanding or Memorandums of Agreement with neighboring communities to help 
each other during times of disaster?

Participate in the Code Enforcement Disaster Assistance Response (CEDAR) Program?

Have a comprehensive plan or strategic plan that addresses natural disasters?

Have a floodplain manager or CEO/Building Inspector who participates in the following organizations: 

 – Association of State Floodplain Managers or NYS Floodplain and Stormwater Managers Association?

 – American Planning Association (APA) or NY Upstate APA?

 – American Society of Civil Engineers (ASCE) or state or local section ASCE?

 – American Public Works Association?

 – NYS Building Officials Conference?

Have a formal evacuation plan?

Have an official debris management plan?

Total number of Yes answers and No answers:

DID YOU KNOW?

Communities with an 
emergency warning 
dissemination plan for 
imminent flooding can earn 
up to 75 points through the 
National Flood Insurance 
Program’s Community  
Rating System.

3.
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MITIGATION MEASURES

Has your community implemented the following ongoing mitigation measures or projects? Check Yes or No .

Mitigation Measures in Place Yes No

Locating or relocation of buildings and infrastructure out of flood-prone areas

Flood-proofing of nonresidential structures

Education programs about mitigation options for your community

Acquisition of repetitive loss structures, infrastructure or property

Incentives-based mitigation measures

Adoption of the most recent International Buildings Codes

 – For NYS, this is the 2015 IBC/IRC

Hiring certified Building Inspectors

Staffing an adequate number of people to enforce building codes

Have completed or planned shoreline restoration projects for critically eroding areas

Require the protection and maintenance of sensitive coastal habitats, ecosystems, and natural features (dunes, 
barrier bars/beaches, wetlands)

Require the protection and maintenance for areas of historical/cultural significance

Have undeveloped public lands such as parks, forests or preserves in the coastal hazard areas (Coastal A Zones)

Access to mitigation equipment (i .e ., sand, sand bags, sand bag machine, pumps, etc .)

Total number of Yes answers and No answers:

Additional Notes

* Note that the Association of Floodplain Managers recommends communities consider higher elevations than the minimum National Flood 
Insurance Program standard.

DID YOU KNOW?

Communities can receive up 
to 1,450 points through the 
National Flood Insurance 
Program’s Community Rating 
System for keeping land 
vacant through ownership  
or regulations.

4.



13

BUSINESS PLANS

What assets do the large retail stores (ex: The Home Depot, Wal-Mart, etc .), grocery stores and fuel distributors in your community  
have to:

 i . stay open during/reopen after a coastal-flooding event; or

 ii . reopen after a weather disaster?

If more than 50 percent of the large retail businesses in your community have the following equipment or plans, mark yes . If fewer 
than 50 percent have the equipment or plans, check no .

Business Equipment/Plans* Yes No

Generators

Backup options for basic needs (water, sewer, food and communications)

Plans to bring in staff to help reopen business

Plans for restocking

Plans for ice distribution

Total number of Yes answers and No answers:

Additional Notes

* Businesses may include functioning marinas or ports as important distribution points after a disaster. If so, consider these as businesses for this section.

DID YOU KNOW?

Having a capital improvement 
program that corrects 
drainage problems can 
earn a community up to 70 
points through the National 
Flood Insurance Program’s 
Community Rating System.

5.
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SOCIAL SYSTEMS

Are there social systems that define your community or serve as the core of the community? Check Yes or No .

Social System Category Yes No If yes, describe relationship

Ex: Strong faith-based networks ü Church networks

Strong faith-based networks (counted on during a disaster)

Cultural identity (unified Hispanic, Asian or other ethnic communities)

Neighborhood associations that support members in times of need

Business cooperative of working relationships (industries that employ 
many residents, Chamber of Commerce, other business-related  
networks, etc .)

Strong civil organizations (Kiwanis Club, Rotary Club, etc .)

Active community center

Established social network groups (ex: Facebook, Nextdoor) for 
communicating with residents .

Total number of Yes answers and No answers:

Additional Notes

6.

DID YOU KNOW?

Developing a Program for 
Public Information (PPI) to 
disseminate relevant flood-
related messages to the 
community on an annual 
basis can earn up to 200 
points through the National 
Flood Insurance Program’s 
Community Rating System.
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DETERMINING YOUR RESILIENCE INDEX

Number of 
check marks

Percentage of 
infrastructure and facilities 

functioning during or 
after coastal flooding/after 

weather disaster

Resilience 
Index

0–3 0–27% LOW

4–7 28–63% MEDIUM

8–11 64–100% HIGH

Number of 
check marks

Percentage of  
critical facilities  

functioning during or 
after coastal flooding/after 

weather disaster

Resilience 
Index

0–5 0–27.5% LOW

6–11 27.6–60.5% MEDIUM

12–18 60.6–100% HIGH

To determine your Resilience Index for each section, use the following tables, which are based on the totals you entered for each section of 
the Index .

Section 1B: Critical Facilities

Total number of critical facilities functioning after  
a disaster:  ______

Your critical infrastructure Resilience Index is  ____________  .

Find out what your Resilience Index means on page 17 .

Your critical facilities Resilience Index is  _________________  .

Find out what your Resilience Index means on page 17 . 

Section 1A: Critical Infrastructure

Total number of infrastructure functioning after  
a disaster:  ______

Additional Notes
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Use the box labeled “Total number of Yes answers” from Sections 2–6 to complete the following chart .

TRANSPORTATION, COMMUNITY PLANS, MITIGATION MEASURES,  
BUSINESS PLANS, AND SOCIAL SYSTEMS

Sections 2–6
Number 

of Yes 
answers

Translate number 
of Yes answers to 
Resilience Index

Resilience 
Index Comments

(Example) Section 2: 
Transportation Issues 1

3 or fewer (LOW) 
4 to 7 (MEDIUM)  
8 or more (HIGH)

LOW

A road construction project will create an additional 
evaluation route within a year. Also, we are in talks with the 
local public transportation provider about a program to 
assist evaluation. 

Section 2: Transportation 
Issues

3 or fewer (LOW) 
4 to 7 (MEDIUM) 
8 or more (HIGH)

Section 3: Community 
Plans and Agreements

6 or fewer (LOW) 
7 to 13 (MEDIUM) 
14 or more (HIGH)

Section 4: Mitigation 
Measures

4 or fewer (LOW) 
5 to 9 (MEDIUM) 
10 or more (HIGH)

Section 5: Business Plans
1 or fewer (LOW) 
2 to 3 (MEDIUM) 
4 or more (HIGH)

Section 6: Social Systems
2 or fewer (LOW) 
3 to 5 (MEDIUM) 
6 or more (HIGH)

Additional Notes
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Resilience Index: A Resilience Index is an indicator of your 
community’s ability to reach and maintain an acceptable level of 
functioning and structure after a disaster .

After completing this self-assessment, your Resilience Index 
was identified as LOW, MEDIUM, or HIGH in different categories 
(ex: critical infrastructure and facilities, transportation issues, 
community plans and agreements, etc .) . 

LOW Resilience Index. A low Resilience Index indicates that 
your community should pay specific attention to this category 
and make efforts to address the areas of low rating . If the critical 
infrastructure category received this rating, then reoccupation 
of your community may take more than 18 months before basic 
services are restored . 

INTERPRETING RESILIENCE INDEX RESULTS

MEDIUM Resilience Index. A medium Resilience Index indicates 
that more work could be done to improve your resilience in this 
category . If the critical infrastructure category received this rating, 
reoccupation of your community may take less than 2 months 
before basic services are restored .

HIGH Resilience Index. A high Resilience Index indicates that 
your community is well prepared for coastal flooding and/or the 
weather disasters you considered during this exercise . If the critical 
infrastructure category received this rating, then your community 
probably will not suffer or will have minimal damage (can be 
functional in less than two weeks) to basic services .

NEXT STEPS

Regardless if your community has a HIGH, MEDIUM, OR LOW Resilience Index, you might consider learning about and investigating the 
weaknesses identified during this process . Refer to the references page for additional information on resources, training, and support .

For more information, contact Mary Austerman, NYSG Coastal Community Development Specialist at mp357@cornell.edu . 
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Additional Resources
• Department for International Development

–  https://assets.publishing.service.gov.uk/government/uploads/system/uploads/attachment_data/file/186874/defining-disaster-resilience-
approach-paper.pdf

• Federal Emergency Management Agency 
–  National Flood Insurance Program Community Rating System: https://www.fema.gov/national-flood-insurance-program-community-rating-system 
–  Understanding Your Risks: Identifying Hazards & Estimating Losses: https://www.fema.gov/media-library/assets/documents/4241

• National Oceanic & Atmospheric Administration
– Digital Coast: https://coast.noaa.gov/digitalcoast/
– Coastal Storms Program (Great Lakes Region): https://www.regions.noaa.gov/great-lakes/index.php/project/coastal-storms-program/

• New York Department of State, Office of Planning & Development
– Geographic Information Gateway: https://opdgig.dos.ny.gov/#/home 
– Model Local Laws to Increase Resilience: https://www.dos.ny.gov/opd/programs/resilience/index.html

• New York Sea Grant
– 2017 Flood: http://www.nyseagrant.org/waterlevel2017
–  Lake Ontario Inundation Map Package, Lake Ontario Inundation WebMap, and associated tutorials: https://seagrant.sunysb.edu/articles/t/coastal-

community-development-program-resources-tools-coastal-resilience-index

• New York State Department of Environmental Conservation
– Climate Smart Communities Program: https://www.dec.ny.gov/energy/50845.html 

• New York State Floodplain and Stormwater Managers Association
– https://www.nyfloods.org 

Training
• Federal Emergency Management Agency

–  https://training.fema.gov/

• National Oceanic & Atmospheric Administration Digital Coast Training
–  https://coast.noaa.gov/digitalcoast/training/home.html 

• New York Office of Emergency Management Training Programs
–  http://www.dhses.ny.gov/oem/training/

Networking
• Great Lakes Action Agenda Work Groups

–  https://www.dec.ny.gov/lands/91881.html 

• New York’s Great Lakes Resilience e-List:
– To join the e-list, send an email message from the email address where you want to receive messages posted to the e-list .
– Send the message to: NY-GL-Resilience-L-request@cornell.edu 
– In the subject line of your email, enter the single word: join 
– Leave the body of the message blank

Contact
Mary Austerman
Coastal Community Development Specialist, New York Sea Grant
Phone: (315)331-8415 
Email: mp357@cornell.edu
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* The coastal flooding and weather disaster narratives and charts are provided to help you think 
through community-specific impacts that are likely to occur during these events. These examples 
were developed with data and expertise of the National Weather Service and Northeast Regional 
Climate Center.
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1. Introduction

This tutorial will guide you through how to make inundation maps 
for your community either as part of the New York Sea Grant’s 
(NYSG) Coastal Resilience Index (CRI) or as a standalone exercise . 
The goal is to visualize inundation at different lake levels to bring 
awareness to infrastructure and services that may be at risk . Using 
this tutorial, you will be able to generate a series of maps for your 
community with the following predetermined lake levels scenarios:

• 247 .3 ft: The upper limit of the 4-foot range for Plan 1958 DD

• 249 ft: Benchmark water level (approximate peak water level 
from 2017)

• 249 .5 ft: Future water level scenario

• 250 ft: Future water level scenario

Note that the water levels are based on elevation data and do not 
account for wind-driven effects. These materials were developed by 
New York Sea Grant for Lake Ontario coastal communities.

Disclaimer: The data and maps in this tool illustrate the scale of potential flooding or land exposure at a 
given water level, not the exact location . They do not account for erosion, subsidence, or future construction . 
Water levels are shown as they would appear during calm conditions (excludes wind-driven changes in 
water levels) . The data, maps, and information provided should be used only as a screening-level tool for 
management decisions . As with all remotely sensed data, all features should be verified with a site visit . The 
data and maps in this tool are provided “as is,” without warranty to their performance, merchantable state, or 
fitness for any particular purpose . The entire risk associated with the results and performance of these data 
is assumed by the user . This tool should be used strictly as a planning reference tool and not for navigation, 
permitting, or other legal purposes .

1a. What You Need

• A computer and internet connection

• A printer

• ArcMap Desktop (Version 10 .0 or higher)

 –  To find out which version of ArcMap Desktop you are working 
with, Open the program and go to Help > About ArcMap… 

2. Access the Data

The map and data are provided in a map package ( .mpk) format . 
A map package contains a map document ( .mxd) and the data 
referenced by the layers it contains, packaged into one convenient, 
portable file .

 1.  File management: Create a folder on your computer from 
which you will work . Do not use spaces or special characters 
in the folder name or ArcMap will not be able to access the 
folder . Example folder name: LO_Inundation_Maps2019

 2.  Navigate to the New York Sea Grant Inundation Mapping 
Tools web page:  
https://seagrant.sunysb.edu/articles/r/12972

 3.  Select the Lake Ontario Map Package listed under  
“Lake Ontario Tools”

 4.  Select Download > Save File to save the map package 
( .mpk) to your local drive . (You may need to move it from the 
Downloads folder to the folder you created in Step 1) .

 
 
 
 
 
 5.  Open Map Package

Option 1 (Recommended)

 i . Open ArcMap

 ii .  ArcToolbox: Data Management > Package > 
Extract Package (double-click)

 iii .  Complete Extract Package tool form . For Input Package, 
browse and select the map package ( .mpk) that you 
downloaded in step 3 . For Output Folder, browse and 
select the folder that you created in step 1 . Click OK .

 
 
 
 iv .  Once complete, in ArcMap go to File > Open > navigate 

to the folder that you created in Step 1, which is also now 
where you have extracted the map package to . There will 
be 2 folders: v10 and v107 . If you are working with the latest 
version of ArcMap, v10 .7, open the v107 folder and select 
the  .mxd file to open . If you are working with an earlier 
10 version, open the v10 folder version and select the 
LO_InundationMap (file type: ArcGIS ArcMap Document) 
to open . 

Option 2

 i .  Double-click map package ( .mpk) file in File Explorer . File 
should automatically open in ArcMap .

LAKE ONTARIO INUNDATION MAP PACKAGE TUTORIAL
Developed by Jessica Kuonen and Mary Austerman, New York Sea Grant

https://seagrant.sunysb.edu/articles/r/12972
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LAKE ONTARIO INUNDATION MAP PACKAGE TUTORIAL

 6.  The default size of the map is 11x17 in Landscape orientation . 
Depending on your ArcMap settings, you may need to adjust 
the page size/orientation . File > Page and Print Setup . Select 
Paper Size: Ledger (11x17”), Paper Orientation: Landscape .

 •  If you want to make a map in a different size or orientation 
(ex: Letter (8 .5x11”), change the settings under File > Page 
and Print Setup then adjust the data frame and text boxes 
in Layout View accordingly .

*Once open in ArcMap, you should see a view of Lake Ontario.

3. Create Maps

Create maps for your community by zooming in to areas where 
critical infrastructure and facilities are located . Use Layout View or 
Data View . Customize the map . Display the different Inundation 
Layers individually and/or together, adjusting color and 
transparency as needed . Toggle layers on and off by selecting the 
box next to the layer . Other layers that may be useful to orienting 
yourself and locating critical infrastructure are Roads, Municipal 
Boundaries, and Counties .

3a. Considering Critical Infrastructure and Facilities and 
Different Lake Level Scenarios

The sample list of critical infrastructure and facilities below is a 
sample taken from the NYSG CRI, and is provided as an example of 
an application for this map tool .

Critical Infrastructure

Wastewater treatment/lift system

Storm drains

Power grid (Transformers, substations) and alternate Energy 
Sources (i .e ., solar, wind, etc)

Public water supply

Transportation/evacuation routes

Large-scale shoreline protection (i .e . breakwater, breakwall, etc .)

Places of mass gathering (i .e . fairgrounds, shopping center, etc .)

Critical Facilities

Municipal Hall and Government buildings

Municipal Department of Public Works

Critical Record Storage

Fuel stations

Police station or other law enforcement buildings

Jail, Fire Station(s)/Emergency Medical Service

Communications main office or substations

Emergency Operation Center

Access to Area suitable for disaster response staging & access to 
points of distribution

Evacuation shelters

Hospitals

Vulnerable populations

Hazardous materials facilities

Private industries with hazardous materials

Abandoned, deteriorated, or underused sites and buildings .
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LAKE ONTARIO INUNDATION MAP PACKAGE TUTORIAL

4. Export Maps

When you are happy with your map, return to Layout View to 
finalize the map .

 1.  In Layout View, consider setting a Bookmark so that you can 
return to the same extent at a later time .

 2.  Decide which inundation layers you want to display .

 3.  To update the text at the lower left corner of the map 
(<Location>, <Municipality>, <Date>), double click on the 
text area in the layout view . See Appendix A for examples of 
finished maps .

 4 . Adjust scale bar as needed . 

 5. File > Export Map

• Save in: (navigate to a folder where you would like to export  
the map as a PDF . You may want to create a folder called: 
Exported_Maps)

• File name: (create a file name)

• Save as type: PDF or JPEG

• Resolution: allow for default identified with file type option

• Output Image Quality: Best

• Ratio: 1:1

• Save

5. Print Maps

 Print exported maps as needed .
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247.3 ft w
ater level

LAKE ONTARIO INUNDATION MAP PACKAGE TUTORIAL
Example of a map produced that shows predicted inundation at 247.3’ water level
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249 ft w
ater level (benchm

ark)

LAKE ONTARIO INUNDATION MAP PACKAGE TUTORIAL
Example of a map produced that shows predicted inundation at 249’ water level
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ater levels 

LAKE ONTARIO INUNDATION MAP PACKAGE TUTORIAL
Example of a map produced that shows predicted inundation at four water levels (in feet): 247.3, 249, 249.5, and 250
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LAKE ONTARIO INUNDATION WEBMAP TUTORIAL

1. Introduction

This tutorial will guide you through how to make inundation maps for your community either as part of 
the New York Sea Grant’s (NYSG) Coastal Resilience Index (CRI) or as a standalone exercise . The goal is 
to visualize inundation at different lake levels to bring awareness to infrastructure and services that may 
be at risk . Using this tutorial, you will be able to generate a series of maps for your community with the 
following predetermined lake levels scenarios:

• 247 .3 ft: The upper limit of the 4-foot range for Plan 1958 DD

• 249 ft: Benchmark water level (approximate peak water level from 2017

• 249 .5 ft: Future water level scenario

• 250 ft: Future water level scenario

Note that the water levels are based on elevation data and do not account for wind-driven effects. These 
materials were developed by New York Sea Grant for Lake Ontario coastal communities.
Disclaimer: The data and maps in this tool illustrate the scale of potential flooding or land exposure at a given water level, not the exact location. They do not account for erosion, 
subsidence, or future construction. Water levels are shown as they would appear during calm conditions (excludes wind-driven changes in water levels). The data, maps, and 
information provided should be used only as a screening-level tool for management decisions. As with all remotely sensed data, all features should be verified with a site visit. The 
data and maps in this tool are provided “as is,” without warranty to their performance, merchantable state, or fitness for any particular purpose. The entire risk associated with 
the results and performance of these data is assumed by the user. This tool should be used strictly as a planning reference tool and not for navigation, permitting, or other legal 
purposes.

1a. What You Need

• A computer

• Internet connection

• A printer (optional)

2. Access the WebMap

 1 .  Navigate to the New York Sea Grant New York Sea Grant Inundation Mapping Tools web page: 
https://seagrant.sunysb.edu/articles/r/12972 

 2 . Select the Lake Ontario Web Mapping Application listed under “Lake Ontario Tools”

 3 . Select “View Application” in the top right of your screen .

Developed by Jessica Kuonen and Mary Austerman, New York Sea Grant

https://seagrant.sunysb.edu/articles/r/12972
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3. Explore WebMap

After opening the application, you will see a view of Lake Ontario . Similar to other online mapping 
services (Google Maps, etc .) . Zoom to your community and/or areas of interest . The different water 
levels are displayed as different “layers” in the map legend to the left of the screen . You will need to 
zoom into to nearly county-level in order for the layers to become active (clickable) and the layers will 
likely take some time to load completely .

3a. Add/Remove Layers

Select the Layers button on the Toolbar (circled below) .

The Layers menu will appear to the right of the screen, replacing the legend . There, you can toggle 
inundation layers on and off by selecting the checkbox next to the layer . 
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View Legend in “Layers View” & Change Opacity:

Select the arrow (>) to the right of the layer name to reveal the 
Legend and Opacity tabs . Adjust the opacity as needed using 
the slider bar .

3b. Considering Critical Infrastructure and Facilities and 
Different Lake Level Scenarios

Create maps for your community by zooming in to areas where 
critical infrastructure and facilities are located . Display the different 
Inundation Layers individually and/or together . The sample list of 
critical infrastructure and facilities below is a sample taken from 
the NYSG CRI, and is provided as an example of an application for 
this map tool .

Critical Infrastructure

Wastewater treatment/lift system

Storm drains

Power grid (Transformers, substations) and alternate Energy 
Sources (i .e ., solar, wind, etc)

Public water supply

Transportation/evacuation routes

Large-scale shoreline protection (i .e . breakwater, breakwall, etc .)

Places of mass gathering (i .e . fairgrounds, shopping center, etc .)

Critical Facilities

Municipal Hall and Government buildings

Municipal Department of Public Works

Critical Record Storage

Fuel stations

Policy station or other law enforcement buildings

Jail, Fire Station(s)/Emergency Medical Service

Communications main office or substations

Emergency Operation Center

Access to Area suitable for disaster response staging & access to 
points of distribution

Evacuation shelters

Hospitals

Vulnerable populations

Hazardous materials facilities

Private industries with hazardous materials

Abandoned, deteriorated, or underused sites and buildings .
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4. Export/Print Maps

Select the Print button on the Toolbar, circled below .

Follow steps 1-4, below to add custom title (below as “Name of Location”), legend, and save/print 
your maps . 

Example of exported webmap:

LAKE ONTARIO INUNDATION WEBMAP TUTORIAL
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Credit: New York Sea Grant; Michigan Sea Grant.

2017 LAKE ONTARIO FLOOD

Lake Ontario

Length: 193 miles  Width: 53 miles  Average depth: 283 feet

Maximum depth: 802 feet  Volume: 393 miles3 

Water surface area: 7,340 miles2

Total shoreline length: 712 miles (326 miles in NY) 

Elevation: 243 feet  Retention/Replacement time: 6 years
Watershed includes ≥16K miles of streams and 260 lakes.

Wave action during the 2017 Lake Ontario flood severely undercut the shoreline. 
Photo: Coastal Flooding Survey Project, Cornell University and New York Sea Grant.

As the last lake in the hydrologic series of Great Lakes, Lake Ontario 
has the lowest mean surface elevation of the lakes at 243 feet 
above sea level . The lake’s primary source of inflowing water is 
the Niagara River, draining Lake Erie, with the St . Lawrence River 
serving as the outlet . The drainage basin covers 24,720 square 
miles . The primary drivers of lake levels are precipitation and over-
lake evapotranspiration . Flooding along the Lake Ontario shoreline 
can be induced by high static water levels, storm-related activity, 
such as storm surge and wave runup, or a combination of the two .

Although flooding occurred in 1951, 1952, 1973, 1974, 1976, and 
1993, Lake Ontario reached record high lake levels in 2017, which 
were surpassed in 2019 . Warmer and wetter winter conditions 
across the Great Lakes basin followed by unprecedented rainfall 
over the entire basin throughout the spring of 2017, resulted in 
increased inflows into Lake Ontario from its tributaries and the 
upper Great Lakes . This caused major flooding on the shoreline of 
Lake Ontario and the St . Lawrence River that peaked at 248 .72 feet 
in May 2017 . Impacts from this event included property damage, 
public infrastructure damage, road and park closures, shoreline 
erosion, and untreated sewage dispersal .

Credit: Michigan Sea Grant.

Contributor: Kyla Semmendinger, Department of Biological & Environmental 
Engineering, Cornell University
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2017 LAKE ONTARIO FLOOD

The Village of Sodus Point (Wayne County, NY)

Village size: 960 acres

Lake Ontario shoreline: 1 .86 miles

Sodus Bay Shoreline: 4 .5 miles

Population: 900 people

Total number of housing units: 886 

Number of waterfront housing units: 224

Lowest elevation: 247 .5 feet

With a minimum elevation of 247 .5 feet, the Village of Sodus Point 
(Wayne County, NY) is among the communities first impacted by 
high water levels . The village is 960 acres with 1 .86 miles of Lake 
Ontario shoreline and 4 .5 miles of shoreline on Sodus Bay, which 
is the largest embayment on the south shore of Lake Ontario . 
Recent census data indicates that there are 886 housing units, 224 
being waterfront . Tourism plays a significant role in the Village’s 
economy . Below is a snapshot of some impacts from the Village’s 
perspective . 

• April 10, 2017: sand bagging began; nearly 300,000 sand bags 
were deployed with help from neighboring municipalities, 
Wayne County, high school teams, National Guard, and others .

• April 20 – November 18, 2017: State of Emergency .

• Pumping efforts: To keep the Village dry a number of pumps  
(9 pumps ≥ 3-inches, and 30, 2-inch pumps) ran 24-hours per 
day, 7 days per week, for at least 14 weeks . 

• Homes and businesses sustained crawl space and first  
floor inundation .

• Suspended solids discharge violated; DEC authorized direct 
discharge; temporary force main required to meet demand .

• One property lost 15–25 feet of shoreline .

• One house taken down to avoid collapse .

• Several houses being elevated to avoid future flooding (as of 
2019, 10 were completed and more being planned) .

• Shoreline protection: 28 seawalls toppers constructed,  
9 new seawalls installed; 12 new riprap projects .

Contributors: Dave McDowell, Mayor, Village of Sodus Point, NY and Jayme Thomann, 
Senior Planner, Genesee/Finger Lakes Regional Planning Council
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Flood waters damaged docks, decks and even inundated the inside of some homes. 
Photo: Coastal Flooding Survey Project, Cornell University and New York Sea Grant.

Flooded streets in Sodus Point, NY. Photo: Coastal Flooding Survey Project, Cornell 
University and New York Sea Grant.

The location of Sodus Point, NY. Credit: Jessica Kuonen, New York Sea Grant.
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BLIZZARD

A blizzard is a storm that contains large amounts of snow 
OR blowing snow with winds in excess of 35 mph and 
visibilities of less than 1/4 mile for an extended period of 
time (at least 3 hours).

Benchmark: March 4, 1999

Location: Monroe and Wayne counties

Benchmark Conditions: Heavy rain turned to snow that fell 
at a rate of 2–3 inches per hour over a 6-hour period that 
resulted in 7–28 inches of total snowfall .

Credible Worst-Case Scenario Conditions: As you think 
through a blizzard Credible Worst-Case Scenario, consider  
a snowfall rate of 3–4 inches per/hour, with totals of  
26–48 inches over a 12-hour period . 

Blizzard snowfall nearly completely buried vehicles in a parking lot. Photo: NOAA’s 
National Weather Service (NWS) Collection, Image ID: wea04198, Kevin Shaw, 
NOAA/NOS/OCS.

Blizzard conditions often result in snowfall rates that are nearly impossible for 
road crews to keep roads clear of snow. In the aftermath of a blizzard, sloppy 
roads, vehicles trapped by snow mounds, and piles of plowed snow litter the 
landscape making travel a challenge. Photo: NOAA’s National Weather Service 
(NWS) Collection, Image ID: wea04839, Courtesy of Joe Flood.

The following impacts from the National Oceanic and Atmospheric 
Administration/ National Weather Service’s Storm Event Database 
describe an historic blizzard that hit the region in 1999 .

On March 4, 1999, heavy rain changed to heavy snow as cold air 
circulated into the region . Snow fell at the rate of two to three 
inches per hour . Snowfall amounts were greatest across Monroe 
and Wayne counties, with over two feet falling . The strong winds 
off Lake Ontario resulted in blizzard conditions for nearly six 
hours . Drifts reached four to five feet in places . The New York 
State Thruway (I-90) was closed from Depew to Syracuse . Several 
hundred cars were stranded in the closed section . Then Governor 
George E . Pataki declared Cayuga, Livingston, Monroe, Orleans, 
Oswego, Wayne, and Wyoming counties State Disaster Areas . 
Livingston, Monroe, Ontario, Orleans, Wayne, and Wyoming 
counties were also declared Federal Disaster Areas . The National 
Guard was called on to help remove cars, rescue stranded 
motorists, transport medical staff, and deliver food and medical 
supplies . Schools and businesses were closed throughout the area . 
Nearly 10,000 customers lost power during the storm for up to 
three days .

County Town/City
Total Snowfall 

Reported (inches)

Monroe Hamlin 28

Monroe Perinton and Fairport 26

Monroe Rochester Airport 24

Wayne Ontario 24

Wayne Walworth 23

Monroe Greece and Webster 20

Wyoming Portageville 17

Ontario, Livingston 
and Cattaraugus

Canandaigua, Avon and 
Franklinville

16

Livingston Mt. Morris 15

Livingston Dansville 14

Oswego, Ontario  
and Allegany

Oswego, Honeoye, and 
Angelica

13

Genesee, Allegany  
and Orleans

Batavia, Friendship and 
Albion

12

Cattaraugus, Allegany 
and Wyoming

Olean, Alfred, 
Whitesville, and 
Strykersville

11

Wayne and 
Cattaraugus

Sodus and Salamanca 10

Wyoming Bennington 9

Erie Wales 8

Genesee and 
Chautauqua

Darien and Arkwright 7



33

Blizzard

Variables Benchmark: March 4, 1999 Worst-Case Scenario

Wind Gust (mph) 44 (sustained winds 35 - the definition 
of blizzard) 55–60 (sustained winds 40-45)

Snow (inch) 2–3"/hour 3–4"/hour; totals of 36-48 inches

Event Duration 6 hours on March 4th 12 hours 

Impact Area of the 
Disaster

Erie, Niagara, Monroe, Wayne, Oswego, 
Livingston, Ontario counties

Power Outage Duration 2–3 days 3-4 days (more power outages because higher sustained winds)

Number of People 
Without Power

10,000 Dependent on the population density of the impacted area; you could use the 
benchmark figure as the minimum

Number of People 
Evacuated

No evacuations but shelters opened along the 
thruway because of its closure

Damage None reported for this particular disaster Potential structural damage because of snowload

Other Impacts* 
I-90 closed with several hundred cars 

stranded; schools and businesses closed; had 
to dump snow into the Genesee River

 Similar to benchmark impacts; road closures; people without heat; generator 
illness/deaths; drifting snow; high snow drifts; clearing of snow will take longer

Federal Disaster Area Livingston, Monroe, Ontario, Orleans, Wayne, 
and Wyoming counties

State Disaster Area Cayuga, Livingston, Monroe, Orleans,Oswego, 
Wayne, and Wyoming counties

*Economic loss can be considered; agricultural damages can be for multiple years following the disaster; could impact tourism.

County Property Damage ($)

Orleans County 350K

Monroe County 1.75M

Wayne County 1.25M

Oswego County 250K

Damage (figures based on value of the dollar from the 
year of the event)

Note: If a benchmark has state of emergency, assume that will happen for Credible Worst-Case Scenario.
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FLASH FLOOD FROM HEAVY PRECIPITATION

Benchmark: May 13–14, 2014

Location: Seneca and Yates counties

Benchmark Conditions: Several weather factors came 
together that resulted in 4–5 inches of rain in less than 2 
hours, devastating parts of Penn Yan, New York, and nearby 
areas . This rainfall total has a one percent probability of 
occurring in a given year, making this a 100-year rainfall event . 

Credible Worst-Case Scenario Conditions: A 500-year event 
would result in 10 inches of rain over 3-6 hours . Islip, NY 
experienced 9 inches of rain over 2 hours in 2014 .

Several clusters of thunderstorms moved across the Finger Lakes 
region from May 13–14, 2014 . A narrow band of 4 to 5 inches of 
rain occurred in less than 2-hours over the central portion of 
Yates and Seneca counties . Rainfall resulted in devastating flash 
flooding in Penn Yan, NY that destroyed roads and buildings . 
Total public damages are estimated between 10 and 12 million 
dollars . The following impacts are from the National Oceanic and 
Atmospheric Administration/National Weather Service’s Storm 
Event Database:

Throughout Yates County, creeks overtopped their banks, homes 
flooded, and roads were washed out or impassable . Water 
rescues took place around Italy, NY and Keuka Park, including 
one motorist that was trapped in their vehicle . In Penn Yan, 
catastrophic flash flooding occurred in the downtown area of the 
Village . The hardest hit areas were in the vicinity of Elm Street and 
Champlin Avenue where roads buckled, parking lots caved in, 
and the Owl’s Nest Community Center collapsed . Tractor-trailer 
container boxes were seen floating down the streets, where they 
collided into the Wagner Restaurant causing significant structural 
damage . The foundations of several homes were washed away 
during the flood .

East Valley Road, north of Branchport, NY. Floodwaters were beyond the capacity 
of existing ditches and culverts. Many area roads were damaged from the velocity 
and volume of the floodwater. Photo: Courtesy of Dave Enty (NWS Binghamton).

As floodwater travels across the land, it picks up debris. This house was  
nearly surrounded by debris that was left from receding floodwater.  
Photo: Mary Austerman, New York Sea Grant.

Floodwaters carry sediments as well. After the floodwaters receded, dirt, silt, and 
rocks covered much of this lawn. Photo: Mary Austerman, New York Sea Grant.

A flash flood is a rapid and extreme flow of high water into 
a normally dry area, or a rapid water level rise in a stream or 
creek above a predetermined flood level, beginning within 
six hours of the causative event (e.g., intense rainfall, dam 
failure, ice jam). 
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Benchmark: July 12, 2006

Location: Wayne County

Benchmark Conditions: Over 5 inches of rain fell over a 3–6 hour period . This rainfall total has a one percent probability of occurring 
in a given year, making this a 100-year rainfall event . 

Credible Worst-Case Scenario Conditions: A 500-year event would result in 10 inches of rain over 3-6 hours . Islip, NY experienced 
9 inches of rain over 2 hours in 2014 .

County Property Damage ($) Crop Damage ($)

Orleans County 200K 500K

Monroe County 500K 0

Wayne County 1.5M 200K

Cayuga County 300K 150K

Damage (figures based on value of the dollar from the year of the event)

Note: If a benchmark has state of emergency, assume that will happen for Credible Worst-Case Scenario.

Flash Flood from Heavy Precipitation

Variables Benchmark: July 12, 2006 Worst-Case Scenario

Rain (inch) 5+ inches over 3-6 hours 10 inches over 3–6 hours (9" occurred in 2 hours in Islip, NY in 2014 )

X Year Event
100 year rain event; 25 year rain event at 

Macedon (Wayne County)
500 year rain events

Event Duration One Day

River Crest Height
Crest heights are not representative because 
the flood waters weren't on gaged streams

Injuries None reported There is no way to estimate, but more likely to occur with a 500 year event .

Death Toll None reported There is no way to estimate, but more likely to occur with a 500 year event .

Number of People 
Evacuated

6 homes in Wayne County Dependent on the population density of the impacted area; you could use the 
benchmark figure as the minimum

Damage
6 homes destroyed; roads washed away; 

thousands of cars damaged; crops (squash, 
potatoes, corn, etc .) ruined

Dependent on impacted area; similar to damages that occurred during the 
benchmark; likely more intense and widespread damages

Other Impacts*
Water supply and quality issues; community isolation; human health (mold, 
insects, etc) .

State of Emergency Wolcott (Wayne County)

*Economic loss can be considered; agricultural damages can be for multiple years following the disaster; could impact tourism.
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FLASH FLOOD FROM ICE JAM

Flash flooding from rapid snowmelt and ice jamming occurred 
over a course of days (January 22–26) in 1999 . The following 
impacts are from the National Oceanic and Atmospheric 
Administration/ National Weather Service’s Storm Event 
Database .

Warm temperatures melted nearly two feet of ripe snowpack 
from record snowfall in late December and early January . Wind 
blown ice collected in drainage areas such as inlets, outlets and 
culverts, creating an ice jam . The runoff and ice jamming caused 
flooding in poor drainage and low-lying regions across the area 
with roads closed in some locations for a couple of days . Some 
of the hardest hit areas included Lancaster and Williamsville 
in Erie County, Royalton in Niagara County, Batavia and Corfu 
in Genesee County and Chili in Monroe County . Evacuations 
occurred in Angola, Chili and Lancaster . 

Ice jam flooding occurred in Buffalo area creeks on January 23rd 
and 24th with Cayuga Creek the most serious . Some evacuations 
were necessary and roads were closed in the vicinity of south 
Cheektowaga . Conditions improved on the 25th as the jams 
loosened and moved downstream, causing flooding . Ellicott, 
Tonawanda, and Cazenovia Creeks were above flood stage for 
one to two days; often cresting at night, and led to flooding in 
Bowmansville and Batavia .

East of Lake Ontario, flooding was reported in Lewis County 
along the Moose River due to another massive ice jam .

An ice jam describes pieces of floating ice carried with 
a stream’s current that can accumulate and obstruct 
stream flow. Ice jams often develop upstream of bridges, 
downstream of dams, and at river bends, and can cause 
flooding or flash flooding.

Rapid snowmelt and wind can result in the formation of a temporary ice jam, which 
acts similar to a dam, preventing the natural movement of water. Photo: Courtesy 
of J.I. Garver, Union College.

Ice jams can cause flooding. The formation of a nearby ice jam has caused road 
and homes to flood. Photo: Courtesy of J.I. Garver, Union College.

Benchmark: January 22–26, 1999

Location: Western NY

Benchmark Conditions: Over the course of a few days, flash 
flooding occurred from rapid snowmelt and ice jamming .

Credible Worst-Case Scenario Conditions: As you think 
through a Credible Worst-Case Scenario for flash flooding 
that results from ice jamming, consider deeper snowpack, 
and slightly higher air temperatures for longer period of time, 
causing the snow to melt quicker . 
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Flash Flood from Ice Jam

Variables Benchmark: January 22-26, 1999 Worst-Case Scenario

Air Temperature (F)
56 degrees max temperature over the event's 

duration; above freezing (20–25 degrees 
above normal) for 3 consecutive days

Low 60s; (25-30 degrees above normal) for 3 consecutive days

Snowmelt 2 feet of snow 3-4 feet of snow (Higher snow depths are common in Lake Effect snow regions)

Rain (inch) 0 .28 inch on January 22; 0 .5 inch 22nd–26th  .5-1 inch over the 3 day period

Snow (feet) 2 feet of snowpack on the ground that melted 3-4 feet of snowpack on the ground that melted

Event Duration
2–5 days (January 23 and 24; conditions 
improved on the January 25); flooding 

conditions were variable
3 days, flooding will likely be variable

River Crest Height
Crest heights are not representative because 
during ice jamming levels could be affected 

by ice in the creek/stream/river . 

Number of People 
Evacuated

200 homes in Angola, Chili and Lancaster Dependent on the population density of the impacted area; you could use the 
benchmark figure as the minimum

Damage $1 .2M across Erie, Genesee, Monroe, Niagara 
and Orleans counties Similar damages likely to occur

Other Impacts*
Road closures; some basement/ 

urban flooding

Similar impacts are likely however more intense; potential winter recreation 
evacuations, deaths, loss in revenue (a lot of water quick; flash flood); potential 
structural damage from snowload

*Economic loss can be considered; agricultural damages can be for multiple years following the disaster; could impact tourism.

County Property Damage ($)

Niagara County 65K

Orleans County 25K

Monroe County 105K

Erie County 430K

Genesee County 270K

Livingston County 35K

Chautauqua County 50K

Cattaraugus County 35K

Damage (figures based on value of the dollar from the 
year of the event)

Note: If a benchmark has state of emergency, assume that will happen for Credible 
Worst-Case Scenario. The event duration was variable based on stream capacity, 
runoff rates, etc.
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ICE STORM

The historic ice storm that began on March 3, 1991, crippled parts 
of western and northern New York . The event started with 4–6 
inches of heavy, wet snow that was then coated with ice, and 
lasted for 12-18 hours over the course of two days . Downed trees 
were one of the largest impacts of the event . During the overnight 
hours many were woken by the sound of falling branches and 
trees, many of which landed on power lines, houses and vehicles . 
Recovery often happened with the help of neighbors . The 
Rochester Democrat and Chronicle reported makeshift bed and 
breakfasts providing support for neighborhoods, and electrical 
cords traversing the streets to share much needed power . Homes 
were evacuated because of the lack of heat from power outages . 
In agricultural areas, fruit crop trees were damaged . The following 
occurred as result of downed trees and dangerous/ 
impassible roads:

• Over 300,000 customers were without power for up to 14 days  
(after 7 days 37,500 customers were still without power)

• Then Governor Mario Cuomo declared a state of emergency 
for 19 counties

• Churches and closed schools served as emergency shelters

• Many businesses were closed

Jim Mahoney, formerly of Rochester, recalls being woken to the 
sound of crashing tree limbs . “It was totally dark and nothing 
could really be seen . However, the crashing sounds of tree 
branches falling could be heard from every direction . It was 
very eerie, like being in a war zone with random explosions 
detonating all around . What we were hearing were limbs 
dropping to the ground as the weight of the ice caused them 
to break off . For the next couple of hours we listened to the 
sounds, getting up every so often to peer out the window into 
the darkness .“

An ice storm is used to describe occasions when 
damaging accumulations of ice are expected during 
freezing rain situations. Significant accumulations of ice 
pull down trees and utility lines resulting in loss of power 
and communication. These accumulations of ice make 
walking and driving extremely dangerous. Significant ice 
accumulations are usually ¼ inch or greater.

During ice storms, the weight of the snow and ice often causes trees and utility 
poles to break, leaving roads impassable and people without power for days, and 
in some cases even weeks. Photo: New York Sea Grant.

Trees, tree limbs and utility poles buckle under the weight of heavy, wet snow that 
turned to ice during an ice storm. In some neighborhoods, many large, long-lived 
trees are lost during single events. Photo: New York Sea Grant.

Benchmark: March 3–4, 1991

Location: Western and Northern NY

Benchmark Conditions: Over a period of 12–18 hours, heavy 
snow turned to ice, causing downed trees and utility poles . 
Many were without power for up to 14 days .

Credible Worst-Case Scenario Conditions: As you think 
through a Credible Worst-Case Scenario for an ice storm, 
consider more snow before switching to ice, greater ice totals, 
and the event lasting for longer than 18 hours . 

He goes on to describe the scene as the sun rose . “Tree branches 
were down all around, those remaining had tons of ice burdening 
them . . .and the ice kept coming from the sky . The storm finally 
tapered off Monday March 4, after more than 16 hours . For miles, 
everything standing was coated by more than an inch of ice . 
The falling trees and power lines and subsequent loss of power 
brought the area to a virtual standstill…for days .”
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Ice Storm

Variables Benchmark: March 3–4, 1991 Worst-Case Scenario

Snow (inch)
4–6" inches of heavy wet snow coated with 
ice across the western fringes of the storm

6–10"; ice changes over to wet snow at the end of the event

Ice (inch) 1–2" 4–5"; 1998 ice storm had 5" ice in Jefferson and St . Lawrence counties and Canada

Event Duration

12–18 hours of ice over two days; freezing 
rain fell in Rochester for 17 consecutive hours . 
Virtually everything shut down through March 

5th . Rochester schools were closed all week . 

18–24 hours of ice

Power Outage Duration Full restoration March 16th (14 days) 2–3 weeks; dependant on power company restoration crews and coverage area

Number of People 
Without Power

325,000 customers (more than 
750,000 people)

Dependent on population density; but majority of people in the coverage area 
would likely be without power; you could use benchmark as the minimum

Injuries
Minor . Mainly from falling ice or limbs . These 
numbers are probably low due to timing of 

the storm (late at night/before sunrise) .

Injuries are possible; carbon monoxide from generators, falling trees, car 
accidents, slipping on ice, power outage

Death Toll None Deaths possible see injuries above

Number of People 
Evacuated

1,000 homes Dependent on population density, temperatures, power outage duration

Damage Property, infrastructure, and crop damage
Possible property damage (downed trees and utility poles, fruit trees, lumber 
forest, trees on structures, snowload issues if snow present, etc . )

Other Impacts*
"High water flooded basements when 

sump pumps were unable to work due to 
power failures"

Similar to benchmark other impacts; river and lowland flooding; possible 
road closures; debris management; possible need to open shelters; economic 
impact from businesses being closed; supply shortages; dairy farms can't milk 
without generator

Federal Disaster Area
Allegany, Genesee, Jefferson, Lewis, Livingston, 
Monroe, Ontario, Orleans, St . Lawrence, 
Steuben, Wayne, Wyoming and Yates counties

State Disaster Area

Allegany, Cattaraugus, Cayuga, Chemung, 
Genesee, Jefferson, Lewis, Livingston, Monroe, 
Ontario, Orleans, Oswego, St . Lawrence, 
Schuyler, Seneca, Steuben, Wayne, Wyoming 
and Yates counties

Note: If a benchmark has state of emergency, assume that will happen for Credible Worst-Case Scenario.

County Property Damage ($) Crop Damage ($)

Niagara County 20M 1M

Orleans County 25M 1M

Monroe County 35M 1M

Wayne County 25M 1M

Cagyuga County 10M 500K

Oswego County 15M 1M

Jefferson County 15M 1M

Erie County 45M 500K

Damage (figures based on value of the dollar from the year of the event)

County Property Damage ($) Crop Damage ($)

Genesee County 25M 500K

Livingston County 15M 1M

Ontario County 25M 1M

Wyoming County 20M 1M

Chautauqua County 5M 500K

Cattaraugus County 10M 1M

Allegany County 10M 1M

References

Jim Mahoney, formerly of Rochester: http://www.progrocher.com/pix/IceStorm/ice1.htm 

The Rochester Democrat & Chronicle: https://www.democratandchronicle.com/story/news/2019/03/03/ 
ice-storm-1991-rochester/3048857002/, https://www.democratandchronicle.com/story/news/2019/03/03/
ice-storm-1991-rochester/3048857002/ 

The Post: https://www.monroecopost.com/news/20160211/column-remembering-great-ice-storm-of-1991 

http://www.progrocher.com/pix/IceStorm/ice1.htm
https://www.democratandchronicle.com/story/news/2019/03/03/ice-storm-1991-rochester/3048857002/
https://www.democratandchronicle.com/story/news/2019/03/03/ice-storm-1991-rochester/3048857002/
https://www.democratandchronicle.com/story/news/2019/03/03/ice-storm-1991-rochester/3048857002/
https://www.democratandchronicle.com/story/news/2019/03/03/ice-storm-1991-rochester/3048857002/
https://www.monroecopost.com/news/20160211/column-remembering-great-ice-storm-of-1991
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WINDSTORM

Benchmark Date: September 6–7, 1998

Location: Central and Western New York

Benchmark Conditions: Two derecho events brought wind 
gusts of 90–95 mph .

Credible Worst-Case Scenario Conditions: As you think 
through a high wind event Credible Worst-Case Scenario, 
consider wind gusts of 120-130 mph, which are the strongest 
winds measured for a derecho .

A derecho is a widespread and usually fast-moving 
windstorm associated with severe thunderstorms and can 
produce damaging straight-line winds over areas hundreds 
of miles long and more than 100 miles across.

A large tree falls onto a house during a windstorm, causing damage to the structure 
and its contents. Photo: New York Sea Grant.

During these types of events, downed utility poles can result in impassable roads, 
and leave people without power for days, and in some cases even weeks. Photo: 
New York Sea Grant.

A long-lived severe wind event, or derecho, moved across areas of 
New York on September 6–7, 1998, causing widespread damage, 
injuries and death . Some of the most severely impacted counties 
in central and western New York were, Allegany, Cayuga, Monroe, 
Niagara, Onondaga, Oneida, Oswego, Orleans, Seneca and Wayne . 
National Weather Service surveys of Onondaga County alone 
revealed a damage swath 10 to 12 miles long and nearly 30 miles 
wide . Estimated peak wind gusts were near 115 mph, but averaged 
90-95 mph for the event . Hundreds of thousands of people were 
without power for much of Labor Day, and some customers did 
not have their power restored for the better part of a week . The 
following impacts are from the National Oceanic and Atmospheric 
Administration/National Weather Service’s Storm Event Database:

Downed trees, utility poles, and power lines resulting from strong, 
damaging winds and large hail caused the bulk of the damages . 
Many roads were closed and tens of thousands of trees were lost 
in Onondaga County alone . In Syracuse, 150 and 125 year old 
churches were nearly destroyed from powerful wind and portions 
of the steeple and bell tower from one were blown hundreds of 
yards, damaging nearby structures . A large tree crashed through 
the roof of a home and struck an elderly woman who was sleeping . 
She later died from extensive head injuries . University housing was 
damaged and a textile company and strip malls lost most of their 
roofs . Many houses lost shingles and siding, and windows were 
blown out of homes and buildings, including University Hospital . 
Several people sustained minor injuries due to flying debris .

The last day of the New York State Fair was canceled after two 
fatalities and seven injuries . Most temporary structures and tents 
were destroyed, and the National Guard was called in to assist with 
clean up . Onondaga County qualified for Federal Disaster funds .
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Windstorm

Variables
Benchmark: September 6–7, 1998  

(Labor Day Derecho) Worst-Case Scenario

Wind Gust (mph) 90–95 120–130 (strongest winds measured in a derecho)

Hail (inch) 0 .75" 1 .5–2" (this is the typical maximum for hail storms in our region)

Event Duration
10–15 minutes at any one location; it took 2 

hours for the storm to travel the damage path 
on September 6, 1998 (Labor Day)

No change for a single location; if looking at the whole state the total duration 
would be increased to 6–8 hours

Event Impact Area
The wind storm traveled Niagara County 

along Erie Canal past Syracuse . See "Damage 
Path" below .

Power Outage Duration 1 week
1–2 weeks (based on the fact that the Credible Worst-Case Scenario would be 
more widespread and service crews will be needed in more locations; more 
outside crews will need to be called to our area)

Number of People  
Without Power

Hundreds of thousands Dependent on the population density of the impacted area; you could use the 
benchmark figure as the minimum

Injuries
11 injuries (flying debris and a man struck by 

lightning)
Dependent on the population density of the impacted area; you could use the 
benchmark figure as the minimum

Death Toll 3 in Onondaga County
Dependent on the population density of the impacted area; you could use the 
benchmark figure as the minimum

Damage Path 250 miles long, 20–30 miles wide 400 miles long; up to 50 miles wide

Damage

Downed trees and limbs, downed utility 
poles and lines; vehicles; structural damage to 
homes, churches, barns, businesses, hospitals, 

etc .; aircraft at Rochester Airport;  
fruit orchards

Same types of damage as benchmark just more intense and widespread

Other Impacts* Secondary impacts likely from longer power outages such as food storage/gas 
storage; public health; safe drinking water (wells)

State of Emergency Cayuga, Monroe, Onondaga, Wayne, and 
sections of Orleans counties Potentially widespread

Federal Disaster Area
Cayuga, Monroe, Onondaga, and  

Wayne counties
Potentially widespread

State Disaster Area
Cayuga, Monroe, Onondaga, and  

Wayne counties
Potentially widespread

*Economic loss can be considered; agricultural damages can be for multiple years following the disaster; could impact tourism.

County Property Damage ($) Crop Damage ($)

Niagara County 250K 2M

Orleans County 5M +100K hail 5M

Monroe County 21.2M + 350K 2M

Wayne County 10M 500K

Cayuga County 5M 1M

Oswego County 500K 1M

Allegany County 15K 0

Damage (figures based on value of the dollar from the year of the event)
Note: If a Benchmark has state 
of emergency, assume that will 
happen for Credible Worst-Case 
Scenario.
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Additional Notes
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